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Windows Vista and Windows 7 users should
turn UAC off (User Account Control) or/and run
Metatrader 4 platform as administrator. See how
to "Run as administrator” in the picture on the
right. You need to do this everytime you start
MT4 platform. If you want permanent solution
you should turn UAC off.

Open

Open file location

%" Run as administrator

Shred with nCleaner
Hex Edit with Hex Warkshop

Send Tao 3
Cut
Copy

Create Shortcut
Delete

Rename

Properties

How to turn UAC off on Windows Vista?
1) Click Windows Start button
2) Go to Control Panel
3) Enter User Accounts window by clicking following icon —~
4) Next go to "Turn User Account Control on or off" :‘f);
5) Uncheck the checkbox "Use User Account Control" and click OK -
6) Restart your computer

dser
Arccounts

How to turn UAC off on Windows 7?
1) Click Windows Start button
2) Go to Control Panel
3) Enter User Accounts window by clicking following icon
4) Next go to "Change User Account Control settings”
5) Move the slider to the bottom with your mouse and click OK
6) Restart your computer
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Hedge EA Demo limitations

LTC Demo has only basic settings and is free to use for one month only on your Metatrader 4
demo account. You are allowed to use LTC Demo for testing purposes only that will help you
decide if you want to purchase the software from www.ea-coder.com

Important things to know before you run
Local Trade Copier

You must have a Metatrader 4 account in order to use Local Trade Copier (LTC) software. LTC
works only on Metatrader 4 platform. LTC Server EA must be installed on the MT4 account(s)
that you want to act as a master account(s) to send the trades. LTC Client EA must be installed
on the MT4 account(s) that you want to act as a slave account(s) to receive the trades.

LTC Demo version is limited to work only for one month. Max two
trades can be copied at a time only. If you have more than 2 trades
open on the master account the LTC Demo will not copy new
trades.

Available only in LTC Personal/Manager/VIP.

By default EA will copy trades that were opened on the server side after the Client EA was
started. This means that if trade was opened on the server side and You start Your Client EA a
few seconds or minutes later it will not be copied. However this not apply when you choose to
follow additional signal providers (if available). In this case trades from new signal provider may
be opened on your account immediatelly if your EA settings comply. Since LTC v2.1 you are able
to control this Client EA behaviour and set it to open trades that were opened before specified
date using IgnoreTradesBeforeTimeStamp setting.

Once the Server EA or Client EA started it will save its input settings into file automatically. The
file will be stored in the \MT4-folder\experts\presets\. On the next EA launch you can easily
load the same settings using "Load" button in the EA Inputs tab in the EA properties window. The
file name will be as follows LTC_Client_Last_Known_Settings_xxxxxx.set where xxxxxx is your
account name.
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Local Trade Copier Installation Guide
Automated installation of Client EA files using installer

Step One: You need to have at least 4 files to run LTC software.
For master account:
1) LTC Server xxxxxx EX4
2) Itc_xxxxxx_master.dll
For slave account:
1) LTC Client xxxxxx EX4
2) Itc_xxxxxx_slave.dll
xxxxxx is usually software license type and it can be one of the following:

e Personal
e Manager
o VIP

e Light

e Demo

Those files will be installed into your chosen Metatrader 4 folders by InstallForex Wizard. To start
installation please run LTC Server xxxxxx.exe and LTC Client xxxxxx.exe

Step Two: After LTC setup wizard is loaded it will scan your computer "Program Files" folder
to find out where your Metatrader 4 platforms are located. Then please click NEXT to get to the
next window where you will be able to choose where to install software

“ ¢ Local Trade Copier Server Light - InstallForex Wizard A EM

Welcome to the LTC Server Light setup wizard

This wizard will install the LTC Server Light w2.0 on your computer,

‘Q lick Mext ko choose wour installation Folder,

Click. Cancel to exit,

-

LOCaL
TRADE COPIER

Server
Light

Llext l [ Cancel
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Step Three: You can choose as many destination folders as you like. Setup wizard will install
software into all selected folders. If your MT4 is not on the list, please use BROWSE button to
add it. Click NEXT to get to the next window where setup wizard will install software files and
give you detailed info what files were copied to your computer. To continue please click NEXT.
“¢ Local Trade Copier Server Light —_]ns_t;IF-::nrex Wizard EMW

Choose Destination Folder

Below vou see the lisk of Metatrader platfarms installed on wour
compuker,
Please choose Folder where to install LTC Server Light and click Mext,

L.

-

Yol can also click Browse button and choose installation Folder that
i= not an this lisk,

LOooaAL e ;
| Cy\Program Files\MT 41 InstaTrader ~
TRADE COPIER [7] C:iProgram FilesiMT 44 InkerbankFs_1-Click

[ Ci\Program Files\MT41MBT MetaTrader 4
¥4l :\Program Files\MT4Meta Trader 4 FinFx

[7] C:\Program Files\MT4iMetaTrader - ABAF: (H

server. [1 Ct\Program FilesiMT4\MetaTrader - ActivTrades il
- [l <:iProgram FilesiMT4iMetaTrader - Alpari (LIS)

ng ht [71 C\Program Files\MT 4 MeataTrader - Forex Place L

1\ Pronram Fileci MT4YMakaTrader - F¥Mnen

[Pr— | p—

Step Four: Once you get to the last setup wizard window please click FINISH.
“¢ Local Trade Copier Server Light - InstallFarex Wizard E@&J

Installation finished

LTiZ Server Light was successfully inskalled an your compuker,

You may need ko restart Metatrader platform if it was running during
this installation,
w Click. Finish to close this window

LOCaL
TRADE COPIER

Run Metatrader

Server
Light

il S o
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Step Five: Launch your Metatrader platform then open your Navigator window (View ->
Navigator or CTRL-N). Under Expert Advisor (EA) you will see LTC Server or LTC Client EA. Click
and drag it from the Navigator window to an open chart. Only one chart needs the EA. Please
attach EA to only ONE single chart. You should now see the set up window as shown below.

Client EA Common Tab

A) Make sure that Allow live trading is checked

B) Make sure that Ask manual confirmation is "NOT" checked
C) Make sure that Allow DLL imports is checked

D) Make sure that Confirm DLL function calls is “NOT" checked

LTC Client Light v20 T e |
Common | [nputs
Commaon Safety
[Ln:nng & Short v] pogitions llow DLL imparts
Enable alerts [ Confirm DLL function callz
| Allo import of extermnal experts

[ Dizable alert once it

Live Trading
Allovs live trading

[] Ak manual confirmation

ok, H Cancel ]| Resst |
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Client EA Inputs Tab and settings

[ T [
LTC Client Light v2.0 e e S|
nputs
" anable Walle
] MagicHumber E0000
e FixedLotSize 0.0
e Lothultipler 1.0
[:-::j D' azhboardCaolar B 70145236
[ Load ]
[ Save ]

[ ak. ][ Caticel ]i Reset ]

Settings in blue color are available only in LTC Personal/Manager license.
Settings in pink color are available only in LTC VIP license.

1. Signal_Provider_ID - This setting is available only in the LTC VIP version and it allows
you to set unique ID for every master account (Server EA) you run on the computer/VPS.
This will create individual groups of trades. So you can have different master accounts
send trades to different groups of slave accounts.

2. FilterMasterAccounts - this feature allows you to select which signal providers (master
accounts) to follow. It means that you can set your Client EA to copy trades only from
certain master account if needed. Usage is simple. For example if you want to receive
trades only from master MT4 accounts 72635, 8375 and 272365 you need to set
FilterMasterAccounts=72635,8375,272365. The MT4 account numbers must be comma
separated and this value must contain only numbers. By default this value is empty and
that means Client EA will receive trades from all master accounts.

3. RiskRatioServer - the most popular money management mode to choose that will
follow exact same risk as signal provider account even if your account is of different size.
If master account risk 5% on a trade, client EA will risk 5% on your account too according
to your account equity. You can set ratio to any value to control risk size. If you set this
value to 1.5 your risk will be 7.5%. Master account can have different risk on every trade
and client EA will handle that as well. To enable this feature please set zero value on
FixedLotSize, LotMultiplier and RiskPercent. Please see important risk management note at
the end of this document.

4. FixedLotSize - Enter the fixed lot size that should be used for each trade. If money
management settings are set incorectly EA will use FixedLotSize by default. To enable this
feature please set zero value on RiskRatioServer, LotMultiplier and RiskPercent. Please see
important risk management note at the end of this document.
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10.

11.

12.

LotMultiplier - This variable is used to set different lot size on the client side
automatically. Lot size received from the master account will be multiplied by this value.
Please see examples of how LotMultiplier can be used at the end of this document. To
enable this feature please set zero value on RiskRatioServer, FixedLotSize and RiskPercent.
Please see important risk management note at the end of this document.

RiskPercent - This variable is used to set lot size according to your account equity in
percent. This value has a limit of 10%. It means that client can not set risk higher than
10% per trade. To calculate lot size by risk in percent the trade must have stop loss set on
the master account. If there is no stop loss EA will delay such trade and will not execute it
until it has stop loss. Client EA show "Delayed" trade count so you can see how many
trades are delayed. To enable this feature please set zero value on RiskRatioServer,
FixedLotSize and LotMultiplier. Please see important risk management note at the end of
this document.

MaxPriceDeviationPips - this is where you set how many pips your current market
(entry) price can be away from original trade entry price. Best to leave this setting as is. If
you change it, please note that your trades may not be executed because of the different
price feeds, spreads, stop and freeze levels among different brokers and account types.
Client EA show "Delayed" trade count so you can see how many trades are delayed
because of the price being too far from the entry. Please do not panic if you did not get
some of the trades, maybe they are delayed. If the value is set to 10, EA will allow 10 pips
adverse price deviation. If you set this variable to a negative number your EA will wait for
a better entry. Example if you set value to -3 pips, EA will wait until your broker market
price will reach better entry by 3 pips and only then open the trade.
CurrencyNamePrefix - Some brokers use additional letters before a standard currency
symbol. An example would be fxEURUSD. If your broker do this, you must enter those
letters exactly as they are in this field. In this example you would enter fx. If none, then
leave blank.

CurrencyNameSufix - Some brokers use additional letters after a standard currency
symbol. An example would be EURUSDFXF. If your broker do this, you must enter those
letters exactly as they are in this field. In this example you would enter FXF. If none, then
leave blank. Client EA will detect currency name suffix automatically if you attach EA to
major currency pair like EURUSD, GBPUSD, USDCHF, etc.

TradePairs - here You can make a comma separated list of currency pairs that EA must
trade. No any other currency pair will be traded. You dont need to use any sufixes or
prefixed in this list, just regular currency pair names. Example: if you want to trade only
GBPUSD and EURUSD you should set TradePairs=EURUSD,GBPUSD

DontTradePairs - here You can make a comma separated list of currency pairs that EA
must NOT trade. You dont need to use any sufixes or prefixed in this list, just regular
currency pair names. Example: if you want to NOT trade AUDUSD and USDCAD you
should set TradePairs=AUDUSD,USDCAD

IgnorePendingOrders - this feature lets you set EA to not place any pending orders
received from the server. If those pending orders will be triggered on the master account,
they will be immediatelly opened on the slave account as market orders. This solves the
problem when the pending orders are triggered only on the master and not on the slave
account because of different spreads between different brokers or different type of
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accounts. Also it is useful if you place a lot of pending orders on the master account and
only 10-20% of them are triggered. By setting this setting to true you can skip a lot of
pending orders placed on slave accounts.

13. OpenNonTriggeredPendingOrders - by default EA will copy trades that were opened
on the master account only after the Client EA was started. This means that if trade was
opened on the master account and you start the Client EA a few seconds or minutes later
it will not be copied. But OpenNonTriggeredPendingOrders setting allows you to set EA to
copy pending orders that were not triggered yet on the master account.

14. ReverseTrades - This feature will reverse all the orders received from the master account,
but it will keep the original SL/TP values. For example, if the master account sends a BUY
trade with a 35 pip SL and a 50 pip TP the Client EA will turn this into a SELL trade with a
35 pip SL and a 50 pip TP. You can swap the SL and TP values using SwapSLTP.

15. SwapSLTP - this feature simply swaps the figures for the TP and the SL around. If the
master account sends a trade with a 35 pip SL and a 50 pip TP the Client EA will keep the
original trading direction but swap the SL from 35 pips to 50 pips and the TP from 50
pips to 35 pips. This can be used in conjunction with the ReverseTrades as well.

16. TakeProfitMultiplier and StopLossMultiplier - this is a multiplication feature of the TP
or SL that the master account sends through. If the Server EA sends a TP of 50 pips and
you have the Client EA set to TP multiplier of 1.5 then the TP will be changed to 75 pips. It
can also work as a negative multiplication to reduce your SL/TP. If you set multiplier to
0.5 then the TP will be changed to 25 pips. Those are active only when
OverrideTakeProfitPips and OverrideStopLossPips are set to zero.

17. OverrideTakeProfitPips and OverrideStopLossPips - this is where you can set your
desired fixed stop loss. It will override original stop loss and take profit. Those settings
are available on the Server EA and the Client EA. This allows you to manipulate stop loss
and take profit. You can set Server EA to send the same fixed stop loss or take profit for
all trades. Or you can set Client EA to set the same fixed stop loss or take profit for all
trades that it received regardless which Server EA sent them. If the trades received from
the master account have no stop loss, you can easily override this using this feature.

18. TakeProfitMoney - take profit value in account currency. This will act as a hidden take
profit and will close all trades when profit reach certain value set by this variable. By
default it is set to zero and it means it is disabled.

19. AlertLevel - this is where you can set alert level. EA can send an email messages to your
configured email account or Push Notifications to your mobile device like Android,
iPhone or iPad. Alert messages are sent when EA stops operating or some other
important events occur. If set to zero this feature is disabled. If set to 1, EA will send alert
message when it stops operating (on most cases, note that if MT4 crash EA will not be
able to send alert message). On the Client EA you can set this value to 2 and you will be
notified about some other important events like if the EA fails to execute a trade. Note
that email account settings must be set in the Metatrader 4 platform under Tools-
>Options->Email and Push Notification settings must be set under Tools->Options-
>Notifications.

20. AlertByEmail - set this value to true if you want EA to send alert messages by email. This
feature is active only if you have AlertLevel value set to 1 or higher.
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21.

22.

23.

24.

25.

26.

27.

28.

AlertByPushNotifications - set this value to true if you want EA to send alert messages
as Push Notifications to your mobile device like Android, iPhone or iPad. This feature is
active only if you have AlertLevel value set to 1 or higher.

MaxTrades - this is where you can set how many trades EA is allowed to open. Very
useful setting when you do not want your client EA to run many trades sent from your
signal provider. By default this feature is set to zero and this means EA is allowed to open
unlimited trades.

Magic Number - this is where you choose what magic number must be set for the
trades. Very important to know that if you set this number to zero, EA will use variable
magic number for every trade instead of using "trade comment" value for remote trade
identification. Magic Number must be set to zero on the MT4 platforms that do not allow
to use "trade comment" value like Oanda MT4. When you run Client EA on Oanda MT4
platform, the Magic Number value will be automatically set to zero and variable magic
numbers used for trade identification. Magic Number must be set to zero (default value)
to enable "Partial Close" feature.

ShiftEntryPips - this setting allows you to shift trade entry price by certain number of
pips. At this point market orders will become pending orders on the slave account.

e Example 1: You have BUY @ 1.3200 on the master; You have ShiftEntryPips=30.0;
the client EA will place BUY STOP pending order @ 1.3230. You can set negative
numbers as well. In the previous example if we had ShiftEntryPips=-50 (negative
number) EA would place BUY LIMIT @ 1.3150.

e Example 2: You have SELL @ 127.50 on the master; You have ShiftEntryPips=30;
the client EA will place SELL STOP pending order @ 127.20. If we had
ShiftEntryPips=-50 (negative number) EA would place SELL LIMIT @ 128.00.

RelativeShift - this setting works with ShiftEntryPips. By default it is set to true. In this
case positive ShiftEntryPips number will shift trade entry forward (up fo buy trades and
down for sell trades). And the negative numbers will shift the entry price back (down for
buy trades and up for sell trades) which means that price will have to retrace back in
order to trigger shifted trade. If you set RelativeShift to false, EA will calculate entry price
by simple math formula where ShiftEntryPips will be added to entry price. So this means
that negative numbers will shift entry price down and positive numbers will shift entry
price up.

ShiftStops - this setting works with ShiftEntryPips. By default it is disabled and EA will not
shift stop loss and take profit with the entry price. Set this value to true if you want EA to
shift stop loss and take profit as well accordingly.

ExcludeMagicNumber - with this variable you can set client EA to ignore trades with the
certain magic number sent from the master account. By default value is set to "-1" which
means this feature is disabled. If you set value to 0 (zero) client EA will ignore manually
opened trades on the master account. Any other number above zero will set EA to ignore
certain trades.

FilterMagicNumber - with this variable you can set client EA to receive only with the
specified magic number. By default value is set to "-1" which means this feature is
disabled. If you set value to O (zero) client EA will receive only manually opened trades on
the master account. Any other number above zero will set EA to receive only certain
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29.

30.

31.

32.

33.

34.

35.

trades from master account that have specified magic number. Very useful if you send
multiple trade groups from the same or multiple master accounts.

TimeLagTradeOpen - this setting allows you to avoid trades opened within some
custom time range. This value is set in seconds. By default it is set to 0 (zero) which
means this feature is disabled. Example: if you set this value to 60, this means that after a
trade is received by client EA, it will ignore any further new trades for the next 60
seconds.

MinLotSizeAllowed - this is where you set min lot size allowed for the trades on slave
account. If this value is set to zero this feature is disabled and there is no minimum lot
size restrictions except for the broker restrictions. This feature works in conjunction with
the IgnoreTooSmallLotSizeTrades. If you set IgnoreTooSmallLotSizeTrades to false, EA will
adjust lot size to the minimum allowed if the lot size is too small. Otherwise if
IgnoreTooSmallLotSizeTrades to true, EA will ignore trades with the lot size that is too
small.

MaxLotSizeAllowed - this is where you set max lot size allowed for the trades on the
slave account. If this value is set to zero this feature is disabled and there is no maximum
lot size restrictions except for the broker restrictions. This feature works in conjunction
with the IgnoreTooBigLotSizeTrades. If you set IgnoreTooBigLotSizeTrades to false, EA will
adjust lot size to the maximum allowed if the lot size is too big. Otherwise if the
IgnoreTooBiglLotSizeTrades is set to true, EA will ignore trades with the lot size that is too
big.

XPairs - this feature is used in conjunction with the XLotMultiplier,
XTakeProfitMultiplier and the XStopLossMultiplier. If you want to adjust lot size, stop
loss and/or take profit for the trades of certain currency pairs you may use these settings.
The XPairs must have the exact pair/symbol names of the trades that you want to adjust.
This is very useful when your broker applies different settings for metals (like Gold, Silver)
or some other non-Forex pairs (like SP500).

MarginLimitPercent - this feature allows you to set limit of the margin used on your
account. This feature helps you to protect your account. By default it is set to 70% and
this means that Client EA will not open new trades if your margin drops below 70%.
These trades will be delayed and once margin used is less than 70% the trades will be
opened if the distance in pips between the market and the open price is less than set by
MaxPriceDeviationPips.

AcceptNewTradeSignals - this feature allows you to control EA if it should accept new
trade signals. By default it is set to true and EA accepts new trade signals. If you set this
value to false EA will not accept new trades and just keep managing the current trades if
there are any.

AcceptTradeModifySignals - this feature allows you to control EA if it should accept
trade modify signals. By default it is set to true and EA accepts trade modify signals, this
means EA will keep managing SL/TP values for all orders and also expiration and entry
price values for the pending orders. If you set this value to false EA will not accept trade
modify signals and will just leave current trade settings how they are at the moment.

36. AcceptTradeCloseSignals - this feature allows you to control EA if it should accept trade

close signals. By default it is set to true and EA accepts trade close signals, this means that
once the trade is closed on the master account it will be immediately closed on the slave
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37.

38.

39.

40.

41.

42.

43.

account as well. If you set this value to false EA will not accept trades close signals and
just keep all trades open until they are closed manually or naturally like hitting SL or TP
value.

ZeroStopLossOrderCloselnSeconds - this feature will close any trade that does not have
stop loss set for a certain number of seconds. Example if you set this value to 60, EA will
wait 60 seconds for any trade to have its stop loss set. If stop loss will not be set in 60
seconds the trade will be closed. This is very useful if you want to protect your account
from trades with zero stop loss sent from the master account. By default it is set to zero
wich means this feature is disabled.

IgnoreTradesBeforeTimeStamp - this feature allows you to control what trades should
be ignored on the Client EA start-up. If you set this value to something like "2012.07.24
10:35", all trades opened until this date will be ignored and the rest (opened after this
date) will be opened immediately if EA settings comply. Be aware that Client EA will use
its broker clock so there could be an offset if your master account broker clock is on a
different timezone. By default this value is empty and EA will copy only the trades that
were opened on the server side after the Client EA was started. This means that if trade
was opened on the server side and You start Your Client EA a few seconds or minutes
later it will not be copied.

LotMultiplier (Server EA) - this setting allows you to send trades with the lot size
already multiplied by certain value. Very useful if you want to send trades from multiple
server EAs with different LotMultiplier.

RemoveStringFromCurrencyName (Server EA) - this value is used to change currency
names of the master trades and is available on the server EA. It is very useful when broker
currency names have special sufix or prefix like "FXF" or "_usd". This setting helps you to
remove those from the currency pairs and send trades to client account having standard
currency names. So for example if you set this value to "FXF", EA will change
"EURUSDFXF" currency name to "EURUSD" and it will be recognized on the client side.
ExcludeMagicNumber (Server EA) - with this variable you can set server EA to ignore
trades with the certain magic number and not send them to the slave account(s). By
default value is set to "-1" which means this feature is disabled. If you set value to 0 (zero)
server EA will not send manually opened trades to the slave account(s). Any other
number above zero will set EA to ignore certain trades.

FilterMagicNumber (Server EA) - with this variable you can set server EA to send only
the trades with the specified magic number. By default value is set to "-1" which means
this feature is disabled. If you set value to 0 (zero) server EA will send only manually
opened trades to the slave account(s). Any other number above zero will set EA to send
only certain trades to the slave account(s) that have specified magic number.
ExcludeTradeComment (Server EA) - with this variable you can set server EA to ignore
trades with the certain "trade comments" and not send them to the slave account(s). The
trades that contains this value in the "trade comments" will be ignored and not sent to
the slave account(s). This variable is case sensitive. By default value is empty which means
this feature is disabled. Example: if you set this value to "Trader" server EA will not send
trades with the "trade comments" like "Trader123" or "Candle Range Trader", but will
send trades with the "trade comments" like "My trader" or "Trade 999".
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44. FilterTradeComment (Server EA) - with this variable you can set server EA to send
trades to the slave account(s) only with the certain "trade comments". Only the trades
that contains this value in the "trade comments" will be sent to the slave account(s). This
variable is case sensitive. By default value is empty which means this feature is disabled.
Example: if you set this value to "Trader" server EA will send only trades with the "trade
comments” like "Trader123" or "Candle Range Trader", but will not send trades with the
"trade comments" like "My trader" or "Trade 999".

45. DiscardLotsLowerThan (Server EA) - this variable tells EA to ignore any trade with the
lot size lower than a given value. If you set it to 0.05, EA will discard trades that have lot
size 0.04 or lower. By default it is set to zero which means this feature is disabled.

46. DiscardLotsHigherThan (Server EA) - this variable tells EA to ignore any trade with the
lot size higher than a given value. If you set it to 1.5, EA will discard trades that have lot
size 1.51 or higher. By default it is set to zero which means this feature is disabled.

47.You can save your settings to make future reinstallations easier. Use the Save/Load
buttons in the EA Inputs tab for this and click the Ok button to finish. Please see page 3
to learn how EA saves the settings automatically on each start-up.

On your Metatrader toolbar, make sure that Experts Advisors is turned on (green):

@ |@ Expert Advisors % ML M

Step Six: Close Metatrader and re-open to make sure EA starts running on startup. Make sure
that you leave your platform open at all times while the Forex markets are open from Sunday
11:00 PM to Friday 9:00 PM London,UK Time Zone. If you are unable to leave your computer on
24/5 or have an unreliable internet connection, you should consider purchasing this low cost
Virtual Private Server (VPS)
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Licenze type: Light (1 masteril slave)

VietaTrader - Alpad LK 4
t means EA is working

rline

econds

the settings,

b again,

You will know that all is fine
when you have a happy face
in the top right corner of the chart. And in the left
top corner you will have blue box dashboard with
the EA settings and other info with a "Server read"”
counter that should be incrementing.

Client EA shows "Delayed" trade count so you can
see how many trades are delayed because of the
price being too far from the entry. You can adjust the
distance using MaxPriceDeviationPips setting. Please
do not panic if you did not get some of the trades,
maybe they are delayed.
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Dashboard (Blue Box)

DashboardDisplay - this setting control how you want EA to display the dashboard (Blue Box).
If this value is set to 0 (zero), EA will not display the dashboard. If you set this value to 1, EA will
display the dashboard without background. If you set this value to 2, EA will display the
dashboard with the background set by DashboardColor. To display dashboard on top of the
chart you may need to uncheck "Chart on foreground” box in the chart properties window (F8)
"Common" tab.

Dashboard position on screen were chosen wisely.

e Notice that the dashboard is aligned to the left but there are space left. This space is
reserved for your trade ticket numbers. Notice when you open trade and MT4 platform
display trade type (buy/sell) and ticket number at the left of the chart. This is why
dashboard is moved a bit to the right to not cover that information.

e Vertical alignment of the dashboard is set to the top but there is some space left and that
is where EA will display critical errors in red bold text. This is very helpful to not miss any
critical errors.

e Dashboard icons are gray when they are not active and when EA wants you to notice

something important the certain icons will turn red.

USEnZHF,M20 0,91907 092001 0.9 1,91997

n There is some space left at

MetaTrader - Alpati LIK 4 . .

gl b the top where EA will display
critical errors in red bold text

5 if there
m the bro

Indicates that broker server
delay detected

q
Indicates if any of the trades

H2BEFINF 42 = . = c
were not opened because
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Dashboard Icons

When dashboard icons are gray they are inactive. When they turn red it means they indicate
something. If you want to reset icon color simply double click icon with your left mouse button
to select it, click right mouse button to open pop-up menu and choose "Delete". See detailed
explanation of each icon.

Indicates if there were any errors from the broker. This could be "trade context busy",
"timeouts", "price re-quotes” errors, etc. Check the "Experts" tab at the bottom of your
Metatrader 4 platform to find error log message for more info. This icon will indicate
"invalid stops" error as well which is very common if you use small take profit and/or stop loss

values as these can disrupt StopLevel Minimum Distance Limitation.

Indicates that broker server delay detected. This is very common on some brokers. This
will affect copy speed, but this is out of control. Copier will synchronize trades 1-2 times
every second and is very fast, but the delay may occur from the broker. You can see
maximum broker delay detected in the Blue Box dashbord.

Indicates if there are any trades being delayed. Trade can be delayed for various reasons
like "max trades value reached set by the trader (see MaxTrades)", "current market price
on slave account is too far from the original entry price (see MaxPriceDeviationPips)",

"stop loss is not set on trade and you have chose RiskPercent money management".

Indicates if any of the trades were not opened because account had not enough money.
Trades usually are of different lot sizes and if you have insufficient money in your
account some of the trades may not be opened. This usually happens when you have
incorrect money management settings or too small account balance. Contact your signal
provider to check what minimum account balance and money management settings you should
use.

Indicates if any of the trades were ignored for various reasons. Trades can be ignored if
there are no such currency pair on the slave account or you have set incorrect currency
pair prefix/sufix if your broker uses one. Trades can be ignored because of the Timelag
or EA is set not to trade certain currency pair. Also trades can be ignored if you have set EA to
exclude/filter trades with the certain magic number or "trade comments".

Indicates if there were disconnects from broker server. Some brokers have unreliable
servers and your Metatrader 4 will get disconnected from the broker server. At this
moment EA will keep running, but it will not be able to make any trading actions.
However disconnect from broker servers usually happens because of the poor internet
connection quality on the client computer. It is strongly recommended to use VPS server were
you can run MT4 platform with the copier software 24/7.
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Indicates if EA is currently in a trading action (open/close/modify). When EA sends
request to the broker server to open, close, modify or delete order this icon will turn red
and stay like this until EA will receive an answer from broker server. During this time EA
will not synchronize trades with the master account(s) or do any other actions, "Server read" will
not grow either. If your broker process requests fast you will not see this icon turn red, but if it
does turn red it means your broker is subject to delays.
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Important and other information

You should be aware that different brokers have different price feeds, spread, stop levels, etc.
This could lead to some trades not executed on the slave accounts.

If you want to report any issue with the copier EA, please contact support and do not forget to
include log files from \Your-Mt4-Folder\experts\logs\ and a screen shot of your chart with the
copier EA running.

What is slippage?

The short answer is that slippage is what happens between the time you close/place an order to
buy or sell a currency and the time that your oder is filled, i.e., the time that the transaction is
completed. In most cases, in a fast-moving volatile market such as EUR/USD (Euros and US
Dollars), from the time you place an order until the time it is filled the exchange rate will often
change anywhere from $.0002 to $.0003 from the price you saw and wanted to get when you
placed your order, even with the fastest automatic electronic ordering software. If you are
trading by hand, i.e., sending your order to your broker via a non-automatic signal generating
platform, then you can expect slippage to be as much as $.0010 to $.0015! The same is applied
when you are closing the trade or deleting pending order.
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Symbol conversion feature

Client EA has special symbol conversion feature built-in. Client EA will look for a special file upon
start-up. File should be named LTC-sct.txt and stored in a \MT4-folder\experts\files\ folder.
The file can contain any number of symbol conversions.

Note that this has nothing to do with the regular currency pair prefix/suffix, because this can be
set in the EA input settings. Of course it can be set in this file as well, but this would only add
extra work.

Symbol conversion feature is very useful for Indices, CFD and Metals. As you may know there are
different names for the same symbols among brokers. It is impossible to create the system that
will work on all brokers because hundreds of brokers exists with different symbol names. Like for
instance on broker #1 you can have symbol named SP500, while on broker #2 this could be
named S&P500 and broker #3 could have _SP500. This will lead to trades ignored and not
copied.

Now image if your master account is broker #1. It has SP500 symbol and you send trades to
those other two brokers (slaves). They should have entries in the conversion files. The broker #2
should have “SP500=S&P500" and broker #3 should have “SP500=_SP500".

Now image if your master account is broker #2. It has S&P500 symbol and you send trades to
those other two brokers (slaves). They should have entries in the conversion files. The broker #1
should have "S&P500=SP500" and broker #3 should have “S&P500=_SP500".

Note that conversion files are not included with the software. You should create conversion file
manually for all brokers you need to use it. This could be a challenge at first, but with this
conversion feature it is great to have a solution.

Note that the same broker may have different symbol names on different account types. Many
brokers use regular symbol names on demo accounts, but when you open real account, you will

see that symbol names may be different.

We will work further on this feature and will try to collect and create as many conversion tables
as possible for major and the most popular brokers.
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How to create symbol conversion file?

Open your favorite text file editor. I personally use Notepad. Enter as many conversion rules as
you need. Each line should have one rule. See example conversion file for FXPrimus broker
demo as slave account when trades are sent from master account on Alpari UK.

NQ100.H=ND
US500.H=S&P500
ZS.H2=Soybean
SB.H2=Sugar

See example conversion file for Alpari UK broker demo as slave account when trades are sent
from master account on FXPrimus (opposite to previous example)

ND=NQ100.H
S&P500=US500.H
Soybean=7ZS.H2
Sugar=SB.H2

See example conversion file for FxPro broker demo as slave account when trades are sent from
master account on Alpari UK.

XAUUSD=GOLD

XAGUSD=SILVER

When you complete adding rules you need, please save the file as LTC-sct.txt into the \MT4-

folder\experts\files\ folder. If LTC client EA was running at this time, please restart it to load
the file.
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Examples on how to use LotMultiplier

Example 1: Signal provider trades on a 1.000 account and your account is 50.000, if you copy
signal provider's trades as is you will get too small profit (loss). So you can set multiplier to 50,
and when signal provider opens 0.1 lot size position you will get 5.0 lot size position.

Example 2: Signal provider trades on a 100.000 account and your account is 20.000. It will be
dangerous to use the same lot size, sometimes it will be impossible. So you can set LotMultiplier
to 0.2 and when signal provider opens 10.0 lot size position you will get 2.0 lot size position. If
resulting lot is smaller then minimum lot size set by your broker copier EA will use minimum lot
size.
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Important note: We have disabled the properties function for the Expert Advisor
“'/H\ which means after installation on the chart, you won't be able to open the
W' properties windows to make any changes. We did this to improve the speed at
#===" which Client EA interacts with the Server EA. If you made an error or want to make
changes such as your lot size, you will need to remove the EA from the chart and reinstall it onto
the chart again. If you saved your settings from the first installation, this process should take less
than a minute. Please see page 3 to learn how EA saves the settings automatically on each start-

up.

Trading foreign exchange on margin carries a high level of risk, and may not be
N\ suitable for all investors. The high degree of leverage can work against you as well
i ' i as for you. Before deciding to invest in foreign exchange you should carefully

K\:_j consider your investment objectives, level of experience, and risk appetite. The

== possibility exists that you could sustain a loss of some or all of your initial
investment and therefore you should not invest money that you cannot afford to lose. You
should be aware of all the risks associated with foreign exchange trading, and seek advice from
an independent financial advisor if you have any doubts.

Disclaimer of Use

To the maximum extent permitted by applicable law, in no event shall Ea-Coder.com Software,
or its suppliers be liable for any special, incidental, indirect, or consequential damages
whatsoever (including, without limitation, damages for loss of business time, business profits,
business information, or any other kind of loss) arising out of the use of, or inability to use the
Software, or the failure to provide support services, even if Ea-Coder.com Software, or one of its
supplies has been advised of the possibility of such damages. Ea-Coder.com Software’s entire
liability shall not exceed the price paid for the software. Ea-Coder.com will not be liable for any
claims of loss, financial or otherwise, resulting from the use of software.

Ea-Coder.com does not sell or provide any Forex trading advise - Ea-Coder.com sells Forex

trading tools. Ea-Coder.com never gives false promises that certain software will make huge
profits on autopilot 24/7 specially without human intervention.
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